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Part B: Subject Specific Skills

	Digital Documentation(Advanced)
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1.  Format              2.  Text wrapping              3.  Cropping
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1. True          2. False          3. True          4. False

Section A: (Objective Type Questions)
A.	 1. b	 2. a	 3. b	 4. a	 5. d
	 6. a	 7. a	 8. a	 9. c	 10. a
B.	 1.	Gallery	 2. Arrangement	 3. envelopes	 4. salutation
	 5.	LE	 6. Flip Vertically	 7. Charcoal	 8. Entries
C.	 1.	False	 2. True	 3. False	 4. True	 5. False
	 6.	True	 7. True	 8. False

1.
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Section B: (Subjective Type Questions)
A.	 1. �The university should use the Mail Merge feature of the Word Processor.
	      Mail Merge is the process of merging a Main Document with the Data source file to create form 

letters that can be invitations, letters, mailing labels or printing certificates for several people.
	 2. The three methods of inserting images in a text document are as follows:
	     • Insert image from Gallery
	     • Using Picture dialog box
	     • Insert image from Scanner
	 3. �Prisha should use Styles feature of the Word Processor to make the task easy.
	 4. Text wrapping option allows a text to wrap around the picture on both left and right side, 

infront or behind the text.
	 5. To draw a line in a document, 
		  Click on the Line tool on the Drawing Toolbar and drag the mouse to draw the desired line.
	 	 If the Drawing Toolbar is not visible, then click View Toolbar Drawing.
	 6. The steps to do paragraph formatting are as follows:
		  Step 1:  Select the paragraph to be formatted.
		  Step 2:  �Click on the Format menu and select paragraph option. The Paragraph window opens.
		  Step 3:  Do the desired changes in the window.
		  Step 4:  Click on OK button.
	 7. Style is a group of formats saved by a specific name and then applied to different sections 

of the documents containing text, tables, lists, etc. While a template is a document that 
contains pre-defined formatting styles, graphics, tables, objects, and other information that 
are commonly used in a particular pattern.

	 8. Adjust Layout Step of the Mail Merge will help you adjust the layout of the parent information 
that will be inserted from the data source file on the main document.

B.	 1. �The advantage of using these templates is that you do not have to waste time in designing a 
format of the document needed. Formats like training document, meeting agenda document, 
resume making layout etc. are already available. You just select them at the time of making 
a new document and fill the content in the blueprint available.

		  The steps to use a document template are as follows:
		  Step 1:  Create a new document or open an existing document. 
		  Step 2:  Add the content with the format, content and styles you want. 
		  Step 3:  �Click on File → Templates → Save. It will open a Template dialog box where you give 

a name to a newly created template. 
		  Step 4:  The template created as an example is given a name as “Science Project Format”. 
		  Step 5:  Click on OK button to save the template.
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	 2. Cropping an image means to trim or scale the selected an unwanted portion of an image 
while the resizing of a picture will alter the resolution of a picture.

	 3. Steps to crop an image are as follows:
		  Step 1:  Right-click on the image. The context menu will appear.
		  Step 2:  Select Picture option from the context menu. The Picture dialog box will appear.
		  Step 3:  Click on the Crop tab in the Picture dialog box and do the required changes.
		  Step 4:  Click on OK button.
	 4. The step to wrap the text on the right side of the image are as follows:
		  Step 1:  Select the image and see the green handles are visible on the edges of the image.
		  Step 2:  Right-click on the image → Picture… → Wrap → Select the desired wrap option.

OR
		  Right-click on the image → Wrap → Select the desired wrap option.
	 5. The advantages of Mail Merge are as follows:
	 	 • It helps us to send the same letter to a large number of people.
	 	 • By using Mail Merge, we don’t have to type each recipient’s name separately in each letter.
	 	 • �It is easy to edit the letter as a single change made in the main letter will be reflected in the 

letters meant for all other recipients.
	 6. A template can be created by using any of the two available methods:
	 	 • Creating a template from a document
	 	 • Creating a Template using a wizard
		  Creating a Template from a Document
		  The steps to create a template from a document are as follows:
		  Step 1:  Create a new document or open an existing document.
		  Step 2:  Add the content with the format, content and styles you want.
		  Step 3:  �Click on File → Templates → Save. It will open a Template dialog box where you give 

a name to a newly created template.
		  Step 4:  The template created as an example is given a name as “Science Project Format”.
		  Step 5:  Click on OK button to save the template.
		  Creating a Template using a Wizard
		  Wizard is a process of doing work using a step by step dialog box. The steps to create a 

template using wizard are:
		  Step 1:  �Create a document according to your requirement and add the desired text and 

styles.
		  Step 2:  �Click on File → Wizard. There is a list of wizards like Letter, Fax, Agenda, Presentation, 

Web Page, etc.
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		  Step 3:  �Different categories of template will have different sets of dialog boxes appearing. 
Follow the steps and then save the template.

C.	 1.	The important features that Shinjini can use to design the birthday card are as follows:
	 	 • Styles
	 	 • Drawing Toolbar
	 	 • Images
	 2.	Advika can use the following methods for adding an image in a document:
	 	 • Insert image from Gallery
	 	 • Insert image from File
	 	 • Inserting Image Using Copy-Paste Option (Using Clipboard)
	 	 • Using Picture dialog box
	 	 • Insert image from Scanner
	 3. a. Steps to draw a rectangular box in the document are as follows:
		  Step 1:  �Click on the Rectangle tool on the Drawing Toolbar.
		  Step 2:  �Drag the mouse to draw the rectangle.
	   b. Two text wrapping options available in a word processing software are as follows:
	 	   • Before
	 	   • After 
	   c. The steps to give a watermark effect to an image are as follows:
		  Step 1:  �Select the image in the document on which you want to apply Graphics mode tool. 

The Picture toolbar appears.
		  Step 2:  �Click on the Graphics mode tool. A drop-down menu appears.
		  Step 3:  �Select Watermark option and see the effect on the image.
	 d. The steps to group different objects created in a document are as follows:
		  Step 1:  �Select multiple objects by using mouse click and holding the Shift key.
		  Step 2:  �Click on Format menu and select Group option. Select Group from the sub menu 

that appears.
OR

		  Right-click to open a context menu and click on Group → Group.
	 4. The Table of Content feature of OpenOffice Writer helps to create an index page.
		  The steps to use this feature are as follows:
		  Step 1:  �Move to the place in a document where you wish to insert a table of contents. 
		  Step 2:  �Select the Insert → Indexes and Tables → Indexes and Tables option from the menu 

bar. The Insert Index/ Table dialog box opens.
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		  Step 3:  �Click on Index/Table tab. 
		  Step 4:  �Click on Entries tab. The different options of the Entries tab appear. These options 

are used to format the entries in the table of contents:
		  Step 5:  �Click on Styles Tab. Use this tab to apply paragraph styles to the table of contents.
		  Step 6:  �Click on the Columns tab. The related options appear.
		  Step 7:  �Click on background tab. It is used to add background colours to the table of contents.
		  After all the above changes are done in all the five tabs the changes can be saved and 

implemented by clicking on OK button. After this the Insert Index/Table dialog box will be 
closed and the table of contents will appear in the document as per changes done in the 
Index/Table window.

Previous Years' Questions

	 1. d	 2. a	 3. b	 4. a	 5. b
	 6. c	 7. c	 8. d	 9. a	 10. d
	 11. a
	 12. Word Processor 
	 13. �Steps to highlight text in an open office writer: Select the first word of text. Then select 

Shift+F8. Move the key arrow to move the next words of text is to be selected. 
	 14. Insert Menu 
	 15. Chapter name, Page number, Book name, Author’s name 
	 16. �Section breaks can be used to separate a document into sections. Section break help in 

following ways: 
	 	 • It adds flexibility to formatting a document. 
	 	 • We can separate the chapters as separate sections in our document. 
	 	 • �We can create different headers & footers, different footnote numbering, change the layout 

of columns, change page borders for different pages, and even change page layouts in 
the same document. 

	 17. Paragraph 
	 18. Header & Footer 
	 19. capitalise each word 
	 20. �A template is a document that contains pre-defined formatting styles, graphics, tables, 

objects, and other information that are commonly used in a particular pattern. Thus, it saves 
our time too. We can create template to design a pattern for leave application, online form, 
brochure, front page of our project, etc. A template is used for creating other documents. 

		�  For example, we can define paragraph and character styles in a document, save the document 
as a template and then use the template to create a new document with the same styles. 
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	 21. �A Style is a set of predefined formatting options that can be applied in a word processor 
document of OpenOffice Writer or MS Word. 

	 22. To insert a page break: 
		  i. Place the cursor where you want to add page break. 
	 	 ii. Click on the Insert tab. 
		  iii. Click on Page Break command from Pages group. 
	 23.	a. Uppercase: All alphabets of the selected text are made upper case.
		  b. Sentence case: The first letter of the sentence is uppercase, and the rest are lowercase.
		  c. A strikethrough is simply a line through the middle of letters. 
	 24.	Types of Charts:
		  i.	 Line Chart: It is used to show trends over a period of time. It is similar to plotting a graph 

on a graph paper with its values on X and Y axis. It uses connecting dots to display trends 
over a period of time.

		  ii.	 Column Chart: It is usually used to display the data in the form of vertical bars. It is used 
to show the changes in data over a period of time or comparison among the different 
data items. The categories are represented on the horizontal axis and the values are 
represented on the vertical axis.
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		  iii.	 Pie Chart: It is a circular chart divided into sectors where each sector shows the relative 
size of each value. It always shows only one data series. It is useful when you want to 
emphasis on a significant element.

		  iv.	 Bar Chart: The bar chart displays the data in the form of long rectangular rods also 
called bars. These bars can be placed horizontally on the chart area. It illustrates the 
comparisons amongst the individual items. In this chart, categories are represented on 
the vertical axis and values are represented on the horizontal axis.

		  v.	 Area Chart: It is used to display the quantitative magnitude of the data graphically. 
These charts are based on the features of the line chart. They basically emphasise the 
area between the line and the axis with the help of the colours, textures, pictures, etc.
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	 25.	To insert a table in a document: 
		  i. Position the insertion point where the table has to be inserted. 
		  ii. Click on Table drop-down button from the standard toolbar. 
		  iii. �Click and hover the mouse pointer across the grid to select the desired number of columns 

and rows. 
		  iv. Release the mouse button. The table will be created. 
	 26.	a
	 27.	Name, Qualification, Work Experience, Contact no. 
	 28.	�A header is the top margin of each page, and a footer is the bottom margin of each page. 

Headers and footers are useful for including material that you want to appear on every page 
of a document such as your name, the title of the document, or page numbers.

OR
		  Four types of tab alignment options available in Word Processor are: 
		  Left: The contents will be aligned towards the left side of the cell. 
		  Right: The contents will be aligned towards the right side of the cell. 
		  Center: The contents will be aligned towards the center of the cell. 
		�  Filled: The contents will be displayed within the column width only. The data which does 

not get accommodated in the cell width will be hidden in the cell. 
		�  Justified: The contents will be displayed completely within the column width by increasing 

the column width. 
	 29.	�A template is a document that contains pre-defined formatting styles, graphics, tables, 

objects, and other information that are commonly used in a particular pattern. Thus, it saves 
our time too. We can create template to design a pattern for leave application, online form, 
brochure, front page of our project, etc. A template is used for creating other documents. 

		�  For example, we can define paragraph and character styles in a document, save the document 
as a template and then use the template to create a new document with the same styles. 

		  To use pre-existing or created template, follow the steps given below: 
		  Step 1:  �Click on ‘File’ menu, then select ‘New’ option. A sub-menu appears. Click on ‘Templates 

and Documents’ from the sub-menu. 
		  Step 2:  Select the required template (Here, NOTES) for the new document. 
		  Step 3:  Click on ‘Open’ button.

LAB ACTIVITY

Do Yourself
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	Electronic Spreadsheet (Advanced)

Page-194
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	 1. The formula for calculating the percentage of Amita = B4/3
		  To copy the same formula for calculating the percentage of the rest of the students in the 

worksheet Click on the cell C4 and drag the mouse to C9.
	 2. Consolidate is used to combine and find the sum/average of marks obtained by the students. 

The steps to do so are as follows:
		  Step 1:  �Create sheet1-weekly test, sheet2-half yearly and sheet3-finals in Final Result.ods.
		  Step 2:  �Select the range B3:B8 in the ‘weekly test’ sheet.
		  Step 3:  �Click on Data tab and select Define Range option. The Define Database Range dialog 

box opens.
		  Step 4:  �Specify the range name and click on OK button. This will give a name to the range 

you wish to use in the data consolidation.
		               Repeat the above steps to give a range name for half yearly and finals marks. 
		  Step 5:  �Create Sheet4 and rename it as Final Result for consolidated marks of all three added 

up to generate the final result. Click on cell B4.
		  Step 6:  �Click on Data tab and select Consolidate option. The Consolidate dialog box appears.
		  Step 7:  �Click on ‘Source data range’ drop-down arrow. The data ranges created earlier will 

be displayed.
		  Step 8:  �Click on data range names and click on Add. The data ranges will get added up in 

the Consolidation ranges box. Repeat the step this all the data ranges needed for 
data consolidation are added in the Consolidation ranges box.

		  Step 9:  �After all the three ranges are added the Consolidate dialog box will appear.
		  Step 10:  �The list of the functions is available in the Function drop-down menu. Select the required 

function. In our example taken above we need sum function which is default selected. 
		  Step 11:  �Click on More → Link to source data check box. This will link the data consolidated. This 

option will link the source data with the target data thus allowing the data updation.
		  Step 12:  �Click on OK button. You will see the consolidated marks in the Final Result - Final 

Result Generated in the cells B4:B9. Now you can use this to generate the percentage 
of each child in the percentage column.

	 3.	Yes, the final result will be changed.

2.
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	 1. Yes
	 2. Yes
	 3. Other way to delete a sheet is follow the given steps:
		  Step 1:  �Select the sheet you want to delete.
		  Step 2:  �Click on Edit menu. A drop-down menu opens.
		  Step 3:  �Select Sheet option from the menu. A sub menu opens.
		  Step 4:  �Select Delete option from the menu. A dialog box appears.
		  Step 5:  �Click on Yes to delete the sheet.

Page-232

uiz Bee

	 1.	No
	 2.	Do yourself
	 3.	After clicking on Merge document the Insert dialogue box opens up.
	 4.	We compare documents because If you edit an original worksheet without recording the 

changes made into it then comparing the edited version with the original version is the best 
option to figure out the kind of changes done in the document.

Section A: (Objective Type Questions)
A.	 1. a	 2. c	 3. c	 4. b	 5. c
	 6.	d	 7. c	 8. b	 9. a	 10. a
B.	 1.	.ods	 2. Name	 3. 3	 4. =
	 5.	Internet	 6. Absolute hyperlink	 7. Cell reference
	 8.	deleted
C.	 1.	False	 2. False 	 3. False	 4. True
	 5.	True	 6. True	 7. True	 8. False
D.	 1. e	 2. a	 3. d	 4. b	 5. c

Exercise 
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Section B: (Subjective Type Questions)
A.	 1.	To rename a sheet, follow the given steps:
		  Step 1:  �Right-click on the Sheet name. The context menu will appear.
		  Step 2:  �Select Rename Sheet option from the menu.
		  Step 3:  �Type the new name.
		  Step 4:  �Press Enter key on the keyboard.
	 2.	Relative hyperlink refers to reaching the linked document with respect to the current location 

while absolute hyperlink refers to reaching to the linked file by writing the complete address 
starting from the root directory.

	 3.	Comment in a spreadsheet are essentially notes that may be entered into any cell. It can 
be used to keep track of reminders, make notes for others and cross-reference for other 
workbooks. 

	 4.	Document option will create a hyperlink that moves you to the location either in the same 
worksheet or in another worksheet existing in the software.

	 5.	A file is sometimes required to be accessed by multiple users at the same time for editing. 
For this purpose, the file can be placed in the network so that it can be shared by several 
users and can be accessed simultaneously.

	 6.	The steps to compare the files are as follows:
		  Step 1:  �Open both the original worksheet and the edited worksheet.
		  Step 2:  �Click on Edit menu and select Compare Document… option. The Insert dialog box 

appears.
		  Step 3:  �Select the original worksheet and click on Open button.
		  Step 4:  �The following changes will be marked:
	 	 • Data found in the edited version but not in the original is marked as inserted.
	 	 • Data found in the original file but not in the edited version is marked as deleted.
	 	 • Data which is changed is marked as changed.
		  Step 5:  �This is followed by accepting or rejecting the changes.
		  Step 6:  �Click on OK button to save the changes.
	 7.	To record a macro, follow the given steps:
		  Step 1:  �Create a new worksheet. 
		  Step 2:  �Click on Tools menu and select Macros option and then click on Record Macros. The 

recording will start immediately.
		  Step 3:  �As soon as the record macro becomes active a dialog box of stop recording will be 

activated.
		  Step 4:  �Add the names of five cities, format the list with different colours, font type and size.
		  Step 5:  �After you are done with the steps of your formatting the worksheet. Click on Stop 

Recording.
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		  Step 6:  �After this OpenOffice Basic Macros dialog box will open.
		  Step 7:  �Click on (+) sign in front of My Macros → Standard → Modules1.
		  Step 8:  �Now enter the name of the macros in the text box Macro name. Let us keep it as M1.
		  Step 9:  �Click on Save button.
B.	 1.	There may be different issues with the shared document whenever you wish to save them:
	 	 • �The document will be saved automatically after you open it and no other user has done 

any changes in the document.
	 	 • After you open a document if any other user has modified then:
		    o �If the changes made by both the user and yourself do not match i.e. if the changes are not 

common, then your document will be saved with both the changes. The changes made 
by the other user will be with RED BORDER.

		    o �For example, if you change the value of cell A10 and the other user changes the value 
of cell B10 then the saved document will have both the changes but B10 with a red 
border.

		    o �If the changes made by both the user and yourself are done for a common cell then at the 
time of saving the document a dialog box saying Resolve Conflicts Dialog appears. Then 
you have to decide which version you want to keep- you’re or the other user’s. After the 
conflicts are resolved then the document will be saved.

		    o �No two or more users can save the same shared document at the same time. If the other 
user is trying to save the same shared document. Then you will not have the permission 
to save it. The document will be locked with the message merge-in in progress. You have 
to cancel the save command and retry later.

	 2.	Hyperlinks helps you to:
	 	 • Move to a specific cell within the current workbook.
	 	 • �Move to a specific location in another file. This file can be a spreadsheet, document, or any 

other file.
	 	 • Accessing a specific website.
	 	 • Sending an email to a specific address.
	 	 • Creating a new file.
	 3.	Steps to sort the data using a Macro.
		  Let us take the example of the given name of the cites to be sorted in the ascending order 

by creating a macro as shown below: 
		  Step 1:	 Create a worksheet with the given list of the cities in cell C4:C20. 
		  Step 2: 	 Select the range B4:B20. 
		  Step 3:	 Click on Tools menu and select Macros option, click on Record Macro. 
		  Step 4: 	 Click on Data menu and select Sort option, click on Sort By -Name → Ascending 
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		  Step 5:  	 Click on OK button. 
		  Step 6:  	 Click on Stop Recording. 
		  Step 7:  	 Specify the name for this new macro as -SORTMACRO_EXAMPLE. 
		  Step 8:  	 Click on Save button. 
		  Step 9: 	 Now select Sheet 2 and enter any 15 numbers in random order. 
		  Step 10:	� Click on Tools menu and select Macros option. Click on Run Macro in the sub menu 

that appear. Choose the name of the saved macro. 
		  Step 11:	 Click on Run button. 
		  Macro will be executed and the numbers are sorted in the ascending order. 
	 4.	Follow the given steps to insert data from an external source:
		  Step 1:  Select the cell in the OpenOffice worksheet where you want to insert an HTML table.
		  Step 2:  �Click on Insert tab and select Link to External Data option. The External Data dialog 

box opens.
		  This dialog box contains the following fields:
	 	 • �URL of the external data source: Click on the three dots … to open a file selection dialog 

box. Then a list of files will be displayed. Select the one needed.
	 	 • �Available tables/ranges: Select the named ranges or tables you want to insert.
	 	 • �Update every: If this option is selected then the ranges or tables are updated every specified 

second/seconds.
		  Step 3:  �Click on OK button to close this dialog and insert the linked data.
	 5.	Whenever a macro is created the code generated equivalent to the instructions given in a 

recorded macro are stored internally in OpenOffice Calc. We can see the code by following 
the given steps:

		  Step 1:  �Click on Tools menu and then select Macros option. A submenu appears on the 
screen.

		  Step 2:  �Click on Organize Macros and then OpenOffice Basic. The OpenOffice Basic Macros 
dialog box will open.

		  Step 3:  �Select M1 Macro created earlier. Click on Edit button. This will open a code window. 
You will see that the code begins with sub followed by a macro name and ends with 
End Sub.

	 6.	The cell reference used in the formula or function can be taken:
	 	 • From different location in the same sheet. 
	 	 • From a different sheet but the same workbook: 
	 	 • From a different workbook.
	 7.	The Goal Seek dialog box opens containing following three options:
	 	 • �Formula cell: In the Formula cell, we can enter the reference of the cell which contains the 
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formula. It contains the current cell reference. We can click another cell in the sheet to apply 
its reference to the text box.

	 	 • Target value: It specifies the value you want to achieve as a new result.
	 	 • �Variable cell: It specifies the reference for the cell that contains the value you want to adjust 

in order to reach the target.
	 8.	Data analysis is an important part of many professional places. It is required to study the 

trends of products required in the local and global market. It is an important part of many 
organizations for planning and taking important decisions for the progress of the company. 
The important data analysis tools available in OpenOffice spreadsheet are Data Consolidation, 
What-if Analysis, Goal Seek and many more. In this unit we will study about these important 
data analysis tools.

C.	 1.	Data Consolidation tool is best suited for Amit.
		  The steps to consolidate data and find average are as follows: 
		  Step 1:  �Create sheet1-periodic test 1, sheet2- periodic test 2 and sheet3- periodic test 3.ods.
		  Step 2:  �Select the range of Marks in the periodic test 1 sheet.
		  Step 3:  �Click on Data tab and select Define Range option. The Define Database Range dialog 

box opens. 
		  Step 4:  �Specify the range name and click on OK button. This will give a name to the range 

you wish to use in the data consolidation.
		  Repeat the above steps to give a range name for periodic test 2 and periodic test 3.
		  Step 5:  �Create Sheet4 and rename it as Final Result for consolidated marks of all three added 

up to generate the final result.
		  Step 6:  �Click on Data tab and select Consolidate option. The Consolidate dialog box appears.
		  Step 7:  �Click on ‘Source data range’ drop-down arrow. The data ranges created earlier will 

be displayed.
		  Step 8:  �Click on data range names and click on Add. The data ranges will get added up in 

the Consolidation ranges box. Repeat the step this all the data ranges needed for 
data consolidation are added in the Consolidation ranges box.

		  Step 9:  �After all the three ranges are added the Consolidate dialog box will appear.
		  Step 10:  �The list of the functions is available in the Function drop-down menu. Select the 

required function. In our example taken above we need Average function.
		  Step 11:  �Click on More → Link to source data check box. This will link the data consolidated. 

This option will link the source data with the target data thus allowing the data 
updation. 

		  Step 12:  �Click on OK button.    
	 2.	Sunil should use Macro tool to do his tasks.
		  The steps to record Macro are as follows:
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		  Step 1:  Create a new worksheet.
		  Step 2:  �Click on Tools menu and select Macros option and then click on Record Macros. The 

recording will start immediately.  
		  Step 3:  �As soon as the record macro becomes active a dialog box of stop recording will be 

activated as shown below:
		  Step 4:  Format the worksheet with required tasks.
		  Step 5:  �After you are done with the steps of your formatting the worksheet. Click on Stop 

Recording.
		  Step 6:  �After this OpenOffice Basic Macros dialog box will open.
		  Step 7:  �Click on (+) sign in front of My Macros → Standard → Modules1.
		  Step 8:  �Now enter the name of the macros in the text box Macro name. Let us keep it as M1.
		  Step 9:  �Click on Save button.
	 3.	Rohit should use Goal Seek.
		  The steps to implement it in a sheet to achieve the required percentage are as follows:
		  Step 1:  �Create a sheet with the given values.
		  Step 2:  �Click on Tools menu and select Goal Seek’ option. The Goal Seek dialog box opens.
		  Step 3:  �The cell address containing the formula is already entered in a ‘Formula cell’ field in 

Default settings field.
		  Step 4:  �Enter the desired result, i.e., 80.
		  Step 5:  �‘Place the cursor in the ‘Variable cell’ field. In the sheet, click in the cell that contains 

the value to be changed.
		  Step 6:  �Click on OK button. A dialog box will be displayed with the message Goal Seek was 

successful.
		  Step 7:  �Click on Yes button.
	 4.	They should use Share document to access the same Spreadsheet to speed up their work.
		  The steps to make the spreadsheet shareable with the other users are as follows:
		  Step 1:  �Open the spreadsheet.
		  Step 2:  �Click on Tools menu and select Share Document option. The Share Document dialog 

box opens where you switch on the sharing option by clicking on the check box Share 
this spreadsheet with other users.

		  Step 3:  �Click on OK button. The Share Document dialog box appears.
		  Step 4:  �Click on Yes button to continue. This will open the file in the shareable mode with 

word shared displayed on the Title bar of the worksheet.
	 5.	Rohan will use Goal Seek to find the money which now he can afford to spend.
	 6. a. Raj should use Record Changes feature to see the changes made by his employees.
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		  b. To start recording changes:
		      Step 1:  �Open the document to be edited.
		      Step 2:  �Click on Edit menu.
		      Step 3:  �Select Changes option.
		      Step 4:  �Click on Record option
		      Step 5:  �Now, start making changes. Changes in a spreadsheet document are highlighted 

by a border around the cells. Content updated is shown by a highlighted border 
around the cell.

		      Step 6:  �Point to the highlighted cell with the mouse pointer, it can be observed that name 
of the author, date, time and a reference to the type of change is displayed.

		  c. Steps to add comments are as follows:
		      Step 1:  �Click on the cell in which changes have been done. It will display the automatically 

created comment through Record Changes activity of Calc.
		      Step 2:  �Click on Edit menu and then select Changes option. Click on Comments from the 

sub menu that appears. 
		      Step 3:  �A dialog box appears on the screen. The automatically added comment provided 

by Calc appears in the title bar of this dialog box. The Title bar cannot be edited. 
		      Step 4:  �Type desired comment. 
		      Step 5:  �Click on OK button.
		  d. To make the changes permanent follow the given steps:
		      Step 1:  �Open the edited worksheet.
		      Step 2:  �Click on Edit menu and then select Changes option.
		      Step 3:  �Click on Accept or Reject option from the sub menu that appears. Accept or Reject 

Changes dialog box appears on the screen.
		      Step 4:  �Based on the suggested review, click on Accept or Reject button. To accept all the 

reviews, click on Accept All button or to reject all the reviews, click on Reject All 
button.

		      Step 5:  �Click on Close button in the Title bar to close the dialog box.
	 7. a. If you want to add a new worksheet, then follow the given steps: 
		      Step 1:  �Select a sheet where you want the sheet to be inserted after it or before it. 
		      Step 2:  �Click on Insert menu and select Sheet option. 

OR 
		      Right-click on Sheet tab and select Insert Sheet option. 

OR 
		      Click on an empty block just after Sheet3. 
		      The Insert Sheet dialog box appears. 
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		      Step 3:  �Select the desired option and click on OK button.
		  b. The steps to rename a sheet are as follows: 
		      Step 1:  �Double-click on the Sheet tab.

OR 
		      Right-click on the Sheet tab and select Rename Sheet option. 
		      By using either of the above step will open the rename dialog box as shown below: 
		      Step 2:  �Delete the old name shaded in blue and type a new name of your choice. 
		      Step 3:  �Click on OK button.
	 	 c. If you want to delete a worksheet, then follow the given steps: 
		      Step 1:  �Right-click on the sheet tab and Select Delete sheet option. A dialog box opens 

to ask for confirmation of deletion of sheet.
		      Step 2:  �Click on Yes button to delete the sheet.
		  d. Adding a hyperlink to connect to the company’s web address.
		      To Link Registered Data Source/Website: 
		      Step 1:  �Go to a specific cell in a worksheet. If there is already some text, then select the 

text. 
		      Step 2:  �Click on Hyperlink icon on the Standard toolbar. 

OR 
		      Click on Insert menu and select Hyperlink option. The Hyperlink dialog box will open.
		      Step 3:  �On the left-hand panel, click the Internet.
		      Step 4:  �Type the target website.
		      Step 5:  �In the Text box in Further settings area, type the text that needs to appear in the 

cell. 
		      Step 6:  �Click on Apply button.
		      Step 7:  �Then click on Close button to finish the process of linking.

Previous Years' Questions
	 1. b	 2. b	 3. b	 4. c	 5. d
	 6.	b	 7. a	 8. b	 9. d	 10. d
	 11. b	 12. a	 13. SUM	 14. row wise, column wise 
	 15. a. =SUM(B3 : E3) 	   b. Multiple operations 
		    c. =MAX(B5 : E5) 	   d. AVERAGE(B3 : B6) 
		    e. = C5 – C4 
	 16. File 
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	 17. �Freeze Panes is spreadsheet means to keep specific rows or columns visible when the 
user scrolls in the worksheet. It is generally used when the initial rows or columns of the 
worksheets contain labels. 

	 18. a. F2 = C2 + D2 
		       F3 = C3 + D3 
		       F4 = C4 + D423 
		       F5 = C5 + D5 
		       F6 = C6 + D6 
		    b. Sort Descending 
		    c. =MAX(F2 : F6) 
		    d. =AVERAGE(C2 : C6) 
		    e. View → orientation → Portrait 
	 19. a. Autosum 
		    b. Right click on sheet tab → Rename 
		    c. Freeze Panes 
	 20. rowwise, columnwise 
	 21. b
	 22. Types of Charts:
		   i.	 Line Chart: It is used to show trends over a period of time. It is similar to plotting a graph 

on a graph paper with its values on X and Y axis. It uses connecting dots to display trends 
over a period of time.

		  ii.	 Column Chart: It is usually used to display the data in the form of vertical bars. It is used 
to show the changes in data over a period of time or comparison among the different 
data items. The categories are represented on the horizontal axis and the values are 
represented on the vertical axis.
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		  iii.	 Pie Chart: It is a circular chart divided into sectors where each sector shows the relative 
size of each value. It always shows only one data series. It is useful when you want to 
emphasis on a significant element.

		  iv.	 Bar Chart: The bar chart displays the data in the form of long rectangular rods also 
called bars. These bars can be placed horizontally on the chart area. It illustrates the 
comparisons amongst the individual items. In this chart, categories are represented on 
the vertical axis and values are represented on the horizontal axis.

		  v.	 Area Chart: It is used to display the quantitative magnitude of the data graphically. 
These charts are based on the features of the line chart. They basically emphasise the 
area between the line and the axis with the help of the colours, textures, pictures, etc.
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	 23. a. =B2 * D2 	 b. =(10 * E2)/100      c. =E2 + F225      d. =MAX(B2 : B7) 
	       e. =COUNT(D2 : D7)
	 24. d
	 25. �Many conditions or items can be used to implement conditional formatting some of which 

are a font, font style, font colour, number format, fill pattern, fill colour, border style, and 
border colour. Selecting different options or conditions will give us the changes we want 
to make in the cell or group of cells.

	 26. c
	 27.	�Calc gives the user an advance formatting feature known as Conditional Formatting. This 

feature enables the user to apply formatting to only those cells in the worksheet which 
satisfy a particular condition. The formatting is not applied to the cells which do not satisfy 
the condition. 

		�  Sorting means grouping some data by class or type or size. Calc has a built-in feature to sort 
lists. Calc can sort a list both in ascending or increasing order and descending or decreasing 
order. In case of both ascending or descending order, Calc first sorts numbers, then alphabets 
followed by blanks cells. 

		�  Filter is an object that removes something from whatever passes through it. The Filter feature 
of Calc gives the user the required information without making any change in the order of 
the list.

LAB ACTIVITY

Do Yourself
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	Database Management System

Page-269

uiz Bee

	 1.	a. Primary Key for the table STATIONARY = SID
	 	     CONSUMER = CID
	 	 b. SID
	 	 c. SID, PRICE, SNAME
	 	 d. SID

Page-281

uiz Bee

	 1.	
	 	 •  Name of the database = Flower shop

3.
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	 Primary keys for:
	 	 •  customer personal information: Customer_ID
	 	 •  Order details: Order_ID
	 	 •  Stock details:Flower_ID
	 2.	•  You cannot enter record in a table without making a primary key.
	 	 •  Yes, we can edit a created table structure. For this, follow the given steps:
		  Step 1:  Click on the table you want to edit.
		  Step 2:  Now, Right-click on it. The context menu appears.
		  Step 3:  Select edit option from the menu.

Page-284

uiz Bee

Primary key: Book ID
Foreign key: Book ID

Primary key: Student ID
Foreign key: Book ID
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Primary key: Book ID
Foreign key: Book ID
•  Relationship between Book in stock and Book issued: One to one
•  Relationship between Book in stock and Book lost: one to many
•  Relationship between Book issued and Book lost: one to one
•  Yes, referential integrity can be set between Books in stock and Books issued. 
•  �Referential Integrity is a very important rule of a DBMS. It deals with the rule that values of Foreign 

key in one table is derived from the values of primary key in another table to ensure that this 
relationship between two tables will provide accurate and consistent data. In other words, no data 
which serves as a link between two tables is either deleted or changed by mistake. In the given 
tables Book ID can be set as referential integrity.

•  Relationship once created can be easily removed by deleting them using the given steps: 
    Step 1: Click on Tools menu. A drop-down menu will appear. 
    Step 2: Select Relationships option from the menu. The Relationship window will appear. 
    Step 3: �Right-click on the relationship thread and select the Delete option. The thread between 

the tables will be removed thus showing that now the two tables are not related. 
    Step 4: �Remove the tables from the Relation Design window. 
    Step 5: �Close the window.

Page-302

uiz Bee

•  SELECT PRICE * QUANTITY FROM ITEM;
•  SELECT * FROM ITEM WHERE PRICE < 50;
•  SELECT NAME, PRICE FROM ITEM ORDER BY PRICE ASC;
•  SELECT * FROM ITEM WHERE NAME LIKE ‘S%’;

Section A: (Objective Type Questions)
A.	 1. d	 2. c	 3. c	 4. c	 5. b
	 6. a	 7. c	 8. c	 9. a	 10. a

B.	 1.	Form	 2. Primary key	 3. Query	 4. Alternate key

	 5.	Report	 6. Attribute	 7. Data Definition Language

Exercise 
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	 8.	Data types	 9. User interfaces	 10. Properties	 11. Report    12. Sorting

      13.	Relational Database

C.	 1.	c	 2. b	 3. d	 4. a

D.	 1.	False	 2. False	 3. True	 4. True

	 5.	False	 6. True	 7. True	 8. False

Section B: (Subjective Type Questions)
A.	 1.	The differences between Entry Required and Default value are as follows:
	 	 • �Entry Required: The field with Entry Required as “Yes” means that the field cannot be left 

blank. The user needs to enter data in this field. It contains a drop-down “Yes”/“No”. The 
default value for this property is “NO” which means the field if left blank will contain a 
NULL(empty/nothing) value.

	 	 • �Default Value: It’s the default value that can be assigned in the field. This value gets 
automatically added in a field at the time of adding a record in a table. The user if want can 
make a change in it. For example, the field “Title”, can be assigned a default value “Ms”.

	 2.	Data Redundancy means keeping multiple copies of the same data in a System.
	 3.	Referential Integrity is a very important rule of a DBMS. It deals with the rule that values of 

Foreign key in one table is derived from the values of primary key in another table to ensure that 
this relationship between two tables will provide accurate and consistent data. In other words, 
no data which serves as a link between two tables is either deleted or changed by mistake.

	 	 Referential Integrity helps in the following conditions:
	 	 • �Whenever a new record is added in a table with the foreign key then it ensures that the 

value added should exist in a primary key of the other linked table.
	 	 • �Updation or deletion in the Table with the primary key is not allowed if the matching record 

exists in the foreign key of the other table.
	 4.	Report is the formatted data displayed from one or more tables or queries. This layout of 

the information is based on a criteria. It is also known as the summary of a table and helps 
in data analysis. For example, creating a report of students who secured 80% and above.

	 5.	The data type available in Numeric data type are as follows:
	 	 • �Yes/No	 • �Tiny Integer	 • �Small Integer
	 	 • �Integer	 • �Big Integer
	 6.	Data is logically organised in a Database so that it can be created and maintained efficiently. 

The software that deals with the creation, updation and retrieval of data from the database is 
known as Database Management System. If this data is accessed by multiple users then the 
database management system provides data consistency and data security. It also provides 
a user-friendly interface so that database objects like tables, queries, forms and reports help 
in easy access and storage of data with different data constraints.
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		  Two advantages of DBMS are as follows:
	 	 • �Data Integrity: Data integrity means that the data is accurate and consistent in the database. 

Data is validated thoroughly using data integrity constraints so that correct data is entered 
in a database. It is also very important since the data is used by multiple users. 

	 	 • �Data Security: DBMS provides data security so that only authorised users can have access 
to the database. For security reasons different users have different privileges. Also, users 
are assigned user ids and passwords for authorised access to the centralised database. 

	 7.	Primary Key: A candidate key that uniquely identifies a row in a tuple by storing Not Null and 
unique values is known as a Primary key.

	 	 Foreign Key: It is an attribute or a set of attributes whose values match the primary key of 
another table. A relationship between two tables matches the primary key of one table with 
the foreign key of another table.

	 8.	The DML commands are:
	 	 • INSERT 	 • UPDATE	 • DELETE
	 9.	� a.  �Text data types store exactly the length specified by user. Pads with tailing spaces for 

shorter strings. Accepts any UTF 8 Character.
	 	 b.  �Memo data types store up to the max length or number indicated by user. It accepts any 

UTF 8 Character.
	 10.	�A query is of great help when information is required to be extracted from different tables. 

It uses the process of filtering the information based on the criteria from the table.
B.	 1.	There are three important types of relationship that can be created in a database which are 

as follows: 
	 	 • �One to one: In this type “Each record of one table is related to only one record of another 

Table”. It is represented as a 1:1 relationship. 
	 	 In the above created table. ONE STUDENT can be in ONE CLASS in a session. 
	 	 • �One to many: In this type “Each record of one table is related to multiple Records of another 

table.” It is represented as a 1:n relationship. 
	 	   �Let us take the example of the above tables where ONE STUDENT can have MULTIPLE 

SUBJECTS. Similarly, ONE TEACHER teaches MULTIPLE CLASSES. 
	 	 • �Many to many: In this type “Each record of one table is related to multiple records of another 

table. Similarly, each record of the second table is related to multiple records of the first 
table.” It is represented as a n:n relationship. 

	 	 In the above tables ONE TEACHER can teach MANY SUBJECTS. ONE SUBJECT is taught by 
MANY TEACHERS.

	 2.	In the OpenOffice Base there are two different methods used to create a table. These are as 
follows: 

	 	 • �Create Table in Design View. 
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	 	 • �Use Wizard to Create Table. 
	 3.	Sorting means rearrangement of the data either in the ascending order (smaller value to 

bigger value) or in the descending order (bigger value to smaller value). The records will be 
rearranged with respect to the sorted field.

	 	 In database, sorting can be done in two ways which are as follows:
	 	 • �Quick sort: If a table size is small and can be accommodated into current memory, then quick 

sort can be used. It is simple and easy method of sorting. In this method a pivot element is 
identified among the values of the column and values less the pivot element is moved to 
the left of pivot and greater than pivot elements are moved to the right of the pivot.

	 	 • �Merge sort: For the larger tables which cannot be accommodated in the current memory, 
this type of sorting is used. It has better performance compared to quick sort. 

	 4.	To open an existing table in a database,
		  Step 1:  Select the table.
		  Step 2:  Double-click on it.

Or
		  Step 1:  Right-click on the table. The context menu will appear.
		  Step 2:  Select Open option from the menu. 
	 5.	The WHERE clause specifies the rows you want to look at while the Order by statement, sorts 

the result set in ascending or descending order.
	 6.	The SQL-DDL contains a set of commands that allows the users to make changes in the 

structure of the table like:
	 	 •  Creating a new data definition using CREATE.
	 	 •  Adding, updating, removing the data definition using ALTER.
	 	 •  Deleting the data definition from the database using DROP.
	 7.	The differences between form and report are as follows:
	 	 •  �Form: Form is a database object which is used to create an interactive user interface by 

connecting it with a table. Each field of a table is displayed in a text box with a Field label 
on one side so that the user can enter, edit and view records in an efficient way. The data 
added, deleted, updated through a form will be reflected in the table connected to the form. 

	 	 •  �Report: Report is the formatted data displayed from one or more tables or queries. This 
layout of the information is based on a criteria. It is also known as the summary of a table 
and helps in data analysis. For example, creating a report of students who secured 80% 
and above. 

C.	 1.	a. SELECT * FROM FRIENDS WHERE City = ‘Delhi’;
	 	 b. SELECT * FROM FRIENDS WHERE Percentage BETWEEN 90 AND 100;
	 	 c. Select Student_Name, City, Gender from Friends WHERE Student_NAME LIKE ‘%a%’;
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	 	 d. Select Student_Name, City, Gender from Friends WHERE Student_NAME LIKE ‘%i_’;
	 	 e. SELECT * FROM FRIENDS ORDER BY Student_Name ASC;
	 	 f. UPDATE Friends SET Percentage = 87 where RollNo = 2;
	 	 g. DESC FRIENDS;
	 	 h. Select Student_Name, City, DOB from Friends WHERE Gender = ‘F’;
	 	 i. Select * from Friends WHERE Year (DOB) Like’%2007’;
	 	 j. ALTER table FRIENDS ADD School varchar(20);
2. 	 a. Table
	 b. Form
	 c. Report
	 d. Query
3.	 To create a database in MYSQL Charu should use command:
	 Create database MYEARTH;
	 To create table named City, she should use command
	 �CREATE TABLE CITY (CITYCODE CHAR(5), CITYNAME CHAR(30), SIZE INTEGER, AVGTEMP 

INTEGER, POLLUTIONRATE INTEGER, POPULATION INTEGER, PRIMARY KEY (CITYCODE));
	 Command to display all the records from the table is
	 SELECT * FROM CITY;

	

+------------+----------------+------+-----------+-------------------+-----------------+
 | CITYCODE | CITYNAME       | SIZE  | AVGTEMP | POLLUTIONRATE | POPULATION   |
+------------+----------------+------+-----------+-------------------+-----------------+
 | 1                | DELHI               |  250   |      32        |                          3 |              200000 |
 | 2                | NEW YORK      |  350   |      26        |                          2 |              150000 |
 | 3                | LONDON         |  314   |      22        |                          2 |              152500 |
 | 4                | TOKYO             |  188   |      24        |                          3 |              124500 |
 | 5                | KATHMANDU  |  164   |      18        |                          1 |                84500 |
+------------+----------------+------+-----------+-------------------+-----------------+

4. 	 a.	Following are the advantages of creating table in database:
	 	 • �Table is an efficient way to summarize the given information in the form of rows and columns.
	 	 • �A table makes the data more understandable and efficient.
	 	 • �Table reduce the complexity of the information or data and represent the visual information 

in more easy format.  
	 b.	We need a primary key in a table because it is a field which is used to uniquely identify records 

in a database. It is a unique field and it cannot be left blank. 
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	 c.	 �In the OpenOffice Base there are two different methods used to create a table. These are as 
follows: 

	 	 • �Create Table in Design View. 
	 	 • �Use Wizard to Create Table. 
	 d.	.odb’ is the file extension for the databases which are created using the OpenOffice org Base.
5.	 a. select * from Stock;
	 b. Select * from Stock WHERE Year (DATE_OF_PURCHASE) Like’%2022’;
	 c. SELECT Price*Quantity FROM Stock;
	 d. SELECT ITEM_ID, ITEM_NAME, DATE_OF_PURCHASE FROM Stock ORDER BY ITEM_NAME 

ASC;
6.	 a. A form in Open Office Base can be created by using any of the two methods: 
	 •	 Use Wizard to Create Form 
	 •	 Create Form in Design View 
	 b. 
		  Step 1:  �After creating all 5 tables discussed earlier in this chapter, click on Tools menu. A 

drop-down menu will appear. 
		  Step 2:  Select Relationships option from the menu.
		  Step 3:  The Add Tables dialog box opens. Select TEACHERS table and click on Add button. 
		  Step 4:  �Select SUBJECTS table and click on Add button. These two tables will appear as shown 

below:
		  Step 5:  �Click on the Close button to close the Add Tables dialog box. 
		  Step 6:  �Now press the mouse button on Subject Code in SUBJECTS table and drag Subject 

Code in TEACHERS table. Release the button to see a line drawn as shown below: 
		  Step 7:  �Click on File menu and select Close button. The relationship created will be saved 

and implemented in the tables.
	 c.	Two types of relationships are as follows:
	 	 One to one: In this type “Each record of one table is related to only one record of another 

Table”. It is represented as a 1:1 relationship.  In the above created table. ONE STUDENT can 
be in ONE CLASS in a session. 

	 	 One to many: In this type “Each record of one table is related to multiple Records of another table.” 
It is represented as a 1:n relationship.  Let us take the example of the above tables where ONE 
STUDENT can have MULTIPLE SUBJECTS. Similarly, ONE TEACHER teaches MULTIPLE CLASSES.

	 d.	Report is the formatted data displayed from one or more tables or queries. This layout of 
the information is based on a criteria. It is also known as the summary of a table and helps 
in data analysis.

	 e.	One way of creating a report is Use Wizard to Create Report. 
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7.	 a. SELECT * FROM TEACHERS WHERE SUBJECT = ‘COMPUTER’;
	 b. SELECT * FROM TEACHERS WHERE SALARY BETWEEN 20000 AND 35000;
	 c. SELECT  SUBJECT FROM TEACHERS WHERE AGE > 40;
	 d. SELECT * FROM TEACHERS ORDER BY NAME ASC;

Previous Years' Questions

	 1.	d	 2. c	 3. c
	 4.	Sorting means rearrangement of the data either in the ascending order (smaller value to 

bigger value) or in the descending order (bigger value to smaller value). The records will be 
rearranged with respect to the sorted field.

	 5.	Two types of relationships are as follows:
	 	 One to one: In this type “Each record of one table is related to only one record of another 

Table”. It is represented as a 1:1 relationship.  In the above created table. ONE STUDENT can 
be in ONE CLASS in a session. 

	 	 One to many: In this type “Each record of one table is related to multiple Records of another 
table.” It is represented as a 1:n relationship.  Let us take the example of the above tables where 
ONE STUDENT can have MULTIPLE SUBJECTS. Similarly, ONE TEACHER teaches MULTIPLE 
CLASSES.

	 6.	The differences between form and report are as follows:
	 	 •  �Form: Form is a database object which is used to create an interactive user interface by 

connecting it with a table. Each field of a table is displayed in a text box with a Field label 
on one side so that the user can enter, edit and view records in an efficient way. The data 
added, deleted, updated through a form will be reflected in the table connected to the 
form. 

	 	 •  �Report: Report is the formatted data displayed from one or more tables or queries. This 
layout of the information is based on a criteria. It is also known as the summary of a table 
and helps in data analysis. For example, creating a report of students who secured 80% 
and above. 

	 7.	Column name/Attribute 	 Data type
		  PNAME		  CHAR
	 	 RUNS	 	 INTEGER
	 8.	INSERT
	 9.	SELECT
	 10. �A Data Definition Language or Data Description Language (DDL) is a standard for commands 

that define the different structures in a database. DDL statements create, modify and remove 
database objects such as tables, indexes and users. Common DDL statements are CREATE, 
ALTER, TRUNCATE, RENAME and DROP. Data Manipulation Language (DML) 
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		    �A Data Manipulation language (DML) is a language that enables users to retrieve, update, 
insert and delete data in a database. Common DML statements are SELECT, UPDATE, INSERT 
INTO and DELETE. 

	 11. i. Numeric Data Type 
		    ii. Alphanumeric Data Type 
	 	   iii. Date/Time Data Type 
	 12.	a. �Forms: Forms enable to provide a user interface for entering of data or to display 

intermediary information. In the Form, the user can add or modify data. 
		  b. �Reports: A report summarizes or displays the information in a format that is suitable for 

viewing or publishing. Reports are used to present the results in a meaningful and useful 
manner. Reports can obtain information from tables or queries. Reports are printed to 
share information. 

		  c. �Table: A table is a collection of logically related records. The multiple records of a database 
are arranged together in a tabular structure to make a table. It is made of rows and columns. 

		  d. �Primary Key: Primary key is a field which is used to uniquely identify records in a database. 
It is a unique field and it cannot be left blank. There can be only one primary key in a 
table. If there are more than one primary keys, then there will be two identities against 
a row. There can be only one identity against a row. So, we cannot have more than one 
primary key. To make retrieval of records faster, Primary keys are indexed in database. 

		  e. DDL – ALTER, DROP 
	 	       DML – SELECT, INSERT 
	 13.	�RDBMS is a relational DBMS in which tables are linked to each other by fields. In addition to 

all the advantages of DBMS, RDBMS helps in the management of a database in a broader 
way. 

	 14.	�Database servers are dedicated computers that can hold the actual databases. It can run 
only the DBMS and its related software. Databases available on the database servers are 
accessed through Command Line or Graphic User Interface tools also called as Frontends. 
Other servers are referred to as Backends that process the request and provides the data. 

	 	  •  �Primary Key: Primary key is a field which is used to uniquely identify records in a database. 
It is a unique field and it cannot be left blank. There can be only one primary key in a table. 
If there are more than one primary keys, then there will be two identities against a row. 
There can be only one identity against a row. So, we cannot have more than one primary 
key. To make retrieval of records faster, Primary keys are indexed in database.

	 	  •  �Foreign Key: The main table of a database is referred to as the ‘Master Table’ and the 
tables in which the related data is stored are referred to as ‘Transaction Table’. The tables 
are related and are linked through a field which is common. This common key field in 
the transaction table is called the ‘Foreign key’ and its value depends on the primary key 
values of the master table. 

	 15.	ClipArt is a collection of pictures or images that can be imported in an office application. 
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		�  Difference between Linking and Embedding an object: When an object is linked, information 
can be updated if the source file is modified. When an object is embedded, it becomes a 
part of the file and does not get updated if the source file is modified. 

	 16.	�DBMS stands for Database Management System. It is a software that controls the creation, 
maintenance and use of a database. 

	 	 �RBDMS stands for Relational Database Management System. In this database system, tables 
are linked to each other by fields and helps in management of database in a broader way. 

	 17.	• �Primary Key: Primary key is a field which is used to uniquely identify records in a database. 
It is a unique field and it cannot be left blank. There can be only one primary key in a table. 
If there are more than one primary keys, then there will be two identities against a row. 
There can be only one identity against a row. So, we cannot have more than one primary 
key. To make retrieval of records faster, Primary keys are indexed in database. 

	 	 • �Foreign Key: The main table of a database is referred to as the ‘Master Table’ and the tables 
in which the related data is stored are referred to as ‘Transaction Table’. The tables are related 
and are linked through a field which is common. This common key field in the transaction 
table is called the ‘Foreign key’ and its value depends on the primary key values of the master 
table. 

	 18.  a. SELECT * FROM STUDENT WHERE HOUSE = ‘GREEN’;
	 	    b. UPDATE STUDENT SET MARKS=MARKS+5 WHERE ADMNO =”1005”;
	 	    c. SELECT * FROM STUDENT WHERE MARKS < 80;
	 	    d. SELECT * FROM STUDENT ORDER BY MARKS DESC;
	 19.  CREATE TABLE EMPLOYEE 
		     ( 
	 	    EMPID Char (4), 
		     EMPNAME Varchar (15), 
	 	    DESIGN Varchar (20), 
		     SALARY Decimal 
	 	    );
	 20. b
	 21.  CREATE TABLE EMPLOYEE 
		     ( 
	 	    EMPID Char (4), 
		     EMPNAME Varchar (15), 
	 	    DESIGN Varchar (20), 
		     SALARY Decimal 
	 	    ); 
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22.	 a. ID 
	 b. INSERT INTO DOCTOR (ID, Department, OPD_DAYS, Doctor_Name) 
	     VALUES (“H608’, ‘Cardiology’, ‘TTS’, ‘Vinita Wapi’); 
	 c. SELECT * FROM DOCTOR WHERE OPD_DAYS =’MWF’, 
23.	� A Data Definition Language or Data Description Language (DDL) is a standard for commands 

that define the different structures in a database. DDL statements create, modify and remove 
database objects such as tables, indexes and users. Two DDL statements are CREATE and ALTER. 

24.	 •	 �Data Definition Language (DDL): A Data Definition Language or Data Description Language 
(DDL) is a standard for commands that define the different structures in a database. DDL 
statements create, modify and remove database objects such as tables, indexes and users. 
Common DDL statements are CREATE, ALTER, TRUNCATE, RENAME and DROP. 

	 •	 �Data Manipulation Language (DML): A Data Manipulation language (DML) is a language 
that enables users to retrieve, update, insert and delete data in a database. Common DML 
statements are SELECT, UPDATE, INSERT INTO and DELETE.  

LAB ACTIVITY

Do Yourself

	Web Applications and Security

Page-343

uiz Bee

1.	 Ease of Access to:
	 •	 enlarge the screen content:  Magnifier
	 •	 use the Ctrl Key with a single hand: Sticky keys
	 •	 enlarge the size of the mouse pointer: Mouse pointer
	 •	 change the color of the cursor: Mouse pointer
	 •	 recognise the speech command: Speech Recognition
2.	 Accessibility features are designed to help people with disabilities use technology more easily. 

4.
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Page-351

uiz Bee

1.	 Do yourself
2.	 Do yourself
3.	 �Two devices that can be used to access any Instant Messaging services are Laptop and Mobile 

phone.
4.	 some examples of wireless connectivity are 
	 •	 Mobile Internet
	 •	 Wi-Fi (Wireless Fidelity)
	 •	 Worldwide Interoperability for Microwave Access (WiMAX)

Page-370

uiz Bee

1.	 A set of programs that identifies and removes malware is known as antivirus software.
2.	 Some online spoofing threats are E mail spoofing and Chat spoofing.
3.	 Two advantages of online shopping are as follows:
	 •	 Easy and convenient access of goods and services.
	 •	 A product or service that is not available in the local market is available online.

Page-375

uiz Bee

1.	 Two fire safety rules followed by our parents at home are as follows:
	 •	 Always keep your home a no-smoking zone. This will minimise the chances of fire hazards.
	 •	 Maintenance of safety equipment like fire extinguishers must be taken care of regularly.
2.	 Two basic rule for using electrical appliances are as follows:
	 •	 Electrical equipment used should be approved by a recognised organization. 
	 •	 Make sure electrical equipment is properly connected, grounded and in good working order. 
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Section A: (Objective Type Questions)
A.	 1. c	 2. b	 3. b	 4. d	 5. a
	 6. a	 7. d	 8. c	 9. c	 10. b
	 11. a	 12. c	 13. c	 14. b	 15. a
	 16. a
B.	 1.	ToggleKeys 	 2. client server	 3. Internet	 4. Serial Keys 
	 5.	IP address	 6. Web browser	 7. Protocols	 8. DSL
	 9.	Yahoo Messenger	 10. BSNL	 11. Personal Area Network 
	 12. Hypertext	 13. Internet	 14. First Aid
C.	 1.	True	 2. True	 3. False	 4. False	 5. False
	 6.	True	 7. True	 8. False	 9. False	 10. False
D.	 1.	b	 2. e	 3. d	 4. c	 5. a

Section B: (Subjective Type Questions)
A.	 1.	The data to be transmitted between sender and receiver is broken down into smaller pieces 

of the same size, called packets. 
	 2.	Online shopping could be useful when:
	 	 • A customer does not have sufficient time to visit stores 
	 	 • A product or service that is not available in the local market is available online.
		    Two popular e-commerce websites are Amazon and Flipkart.
	 3.	Modem converts digital signal to analog that can travel over phone lines.
	 4.	Three advantages of networking are as follows:
	 	 • �File sharing: You can share files like text files, spreadsheets, documents, presentations, audio 

files, video files, etc. amongst different users and access the file from any location if devices 
are interconnected. 

	 	 • �Data Sharing: Data can be easily shared, sent and received through network. 
	 	 • �Resource Sharing (Hardware and Software): Devices like scanners, printers connected through 

the network can be accessed easily by multiple users and hence saves money. 
	 5.	MODEM (Modulator Demodulator) is a device used to convert the digital signals into analog 

signals and vice versa. It is mainly used to connect a telephone to a computer terminal.
	 6.	Five websites that provide blog service are as follows:
	 	 • �Wix (www.wix.com) 
	 	 • �WordPress (www.wordpress.org) 

Exercise 
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	 	 • �LinkedIn (www.linkedin.com) 
	 	 • �Weebly (www.weebly.com) 
	 	 • �Medium (www.medium.com) 
	 7.	The computer that provides services to the other computers connected in a network is called a 

server. The computer that sends the request for the services is called a client. It is only through 
the client the user interacts with the network server and avails its services. Clients are often 
situated at workstations or on personal computers. Servers are located at a different place on 
the network and are more powerful machines as they are responsible for most of the processing 
requirements of the client and the whole network. It is for this reason the architecture of the 
client computer requesting the services of the server is known as a client server architecture.

	 8.	Five websites that allow online transactions are as follows:
	 	 • Flipkart	 • Amazon	 • Myntra	 • Irctc	 • Snapdeal
	 9.	a. DSL: Digital Subscriber Line 
	 	 b. ISP: Internet Service Provider 
		  c. Modem: Modulator Demodulator 
		  d. MAN: Metropolitan Area Network 
		  e. WAN: Wide Area Network 
		  f. P2P: Peer to Peer
	 10. Five tips to manage strong passwords are as follows:
	 	 •  �Use a unique password for your important accounts whether email or online banking. Avoid 

using the same password for different accounts.
	 	 •  �Your password should be at least 12-14 characters long. It should be a combination of 

lowercase and uppercase letters, numbers and symbols. A long password will offer more 
protection than a short password if it is properly constructed.

	 	 •  �Do not use personal information such as your name, age, date of birth, child’s name, pet’s 
name, or favorite color/song when constructing your password.

	 	 •  �Avoid consecutive keyboard combinations (i.e. qwerty or asdfg).
	 	 •  �Look around and make sure no one is watching while you enter your password. If somebody 

is, politely ask them to look away.
B.	 1.	The five security measures to ensure safety from online threats are as follows:
	 	 •  �Install the latest and up-to-date web browser, do not install non-reliable extensions on the 

browser. 
	 	 •  �While surfing through websites ensure to access information from reliable and secured 

websites (https:) 
	 	 •  �Keep deleting Cache/Cookies from the browser. 
	 	 •  �Do not keep passwords and login details saved on the browser, logout from all accounts 

as soon as you complete your work. 
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	 	 •  �Keep the privacy settings of browser to medium/high. 
	 2.	a. �Internet:  It is an interconnected system of computer networks of different types across the 

globe. This interconnected system works on a common communication protocol named 
Transfer Control Protocol/Internet Protocol (TCP/IP) that allows computers to exchange 
information smoothly and efficiently amongst different users connected worldwide. Every 
computer on the internet is identified by a unique IP (Internet Protocol) address. It’s one 
of the most useful technologies available in today’s times and covers every aspect of life 
at home, in offices, surroundings, neighborhoods and everywhere.  

	 	 b. �LAN: It is a network of devices connected within a confined physical area that spans 
few kilometers. For example, computers connected within a school or number of offices 
connected within a building or number of devices connected within a home. 

	 	 c. �Instant Messaging: Instant Messaging is one of the most popular services on the internet. It 
uses Instant message applications to provide an instant way to send and receive messages 
just like a real time conversation between two or more people. 

		     �Both the sender and the receiver have to be online connected through an internet at the 
same time using the same Instant Messaging Application in order to have one to one 
private chat. You can also have audio or video chat. In that case your device should have 
microphones, headsets or speakers and web cameras. Nowadays some instant messaging 
applications allow users to view messages even in their offline mode. These are called 
“Offline Messages”. 

		     �On the other hand, email helps you deliver messages to multiple people at the same time 
irrespective they are online or offline. It is delivered in their mailbox which they can check 
whenever they want.

		  d. �Blog: BLOG stands for weblog is a website used as an online journal or discussion platform 
where users from technical or non-technical background can create their content and post 
it for others to read or share, just like an online personal diary.

	 3.	Four rules or etiquettes to be followed while chatting on the Internet are as follows:
	 	 •  �Introduce yourself before you begin with the conversation. If your chat name does not 

reflect your proper name, then begin by introducing your name. 
	 	 •  �Ask the other person, if he is available and have time to chat. 
	 	 •  �Keep your messages short and precise. It is a better way to communicate especially in a 

professional environment. 
	 	 •  �Use proper punctuations to make it readable and understandable. 
	 4.	a.  �Internet security is a branch of computer security that is responsible to establish rules and 

measures to be followed in case of security breach attacks over the internet. The primary 
objective of internet security is to provide solutions to protect users from attacks that 
travel over the internet. The internet being a hugely used service by people of all walks of 
life, is insecure and is vulnerable to cyber threats like phishing, spoofing, etc.



37Trackpad 402-X (Answer Key)

		      �Phishing is one of the most common cyber-attacks that everyone should learn about in order 
to protect themselves. It is a fraudulent practice of sending emails to reputed companies 
or personnel in order to incite them to reveal their financial and personal information so 
that they can steal sensitive data like credit card or login information, or to install malware 
on the victim’s machine.

		  b. Two best practices for ensuring security over the internet are as follows:
	 	     •  �Do not reveal your OTP/Personal information on any random site for which you are not 

sure. 
	 	     •  �Be very careful when using email IDs of any banking or financial websites as there are 

many cloned websites with similar spellings to make you victim of financial fraud. 
	 5.	Three important points to take care of a Healthy Lifestyle are as follows:
	 	 • Eating nutritious food in proper quantity and at right time. 
	 	 • physical activities like Yoga, morning walk or regular exercise. 
	 	 • �Stress management can be done by mediation, spending time with family and friends, going 

out on vacations.
	 6.	a. �Physical hazards: These are hazards due to change in the surrounding environment like 

noise pollution, vibration and shocks, illumination, radiation, heat, ventilation, air and water 
pollution. 

	 	     �Chemical hazards: It is caused by chemical exposure in the workplace. Workers may suffer 
from respiratory diseases, skin diseases, allergies, heart disease, cancer, and neurological 
disorders. 

		  b. �An accident is an unplanned or unfortunate incident that occurs all of a sudden and may 
lead to unwanted results, hazards, or injury to a person or a group of people. Accidents 
at a workplace can be due to falls, slips and trips. The injuries may vary from minor aches 
to major, severe accidents. Some injuries suffered might include fracture, sprain, knee or 
elbow injuries, wrist or head injuries, etc.

		      �Emergency is a situation that requires immediate attention and if not taken seriously 
might have some serious impact. It might pose a sudden risk to health, life, property or 
environment. One must be alert to notice any kind of emergency and it must be handled 
immediately to prevent further losses and to minimize the loss.

	 	 c. �Spoofing means faking someone’s identity. It is done by fake emails, text messages and 
websites created to look like they’re from authentic companies. They’re sent by criminals 
to steal personal and financial information from you.

		     �Phishing is one of the most common cyber-attacks that everyone should learn about in order 
to protect themselves. It is a fraudulent practice of sending emails to reputed companies 
or personnel in order to incite them to reveal their financial and personal information so 
that they can steal sensitive data like credit card or login information, or to install malware 
on the victim’s machine.
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	 7.	Three important points to remember while handling accidents at the workplace are as follows:
	 	 • �An immediate action like calling the ambulance, police or any other assistance should be 

taken to have minimum damages. 
	 	 • �First aid to be given to a person directly affected by an accident. 
	 	 • �Every organization must follow SOP for handling accidents. 
	 8.	Three basic rules of First Aid are as follows:
	 	 • �There should always be a systematic approach for all types of medical emergencies. 
	 	 • �Do not estimate the situation or the injury on your own. All injuries should be taken seriously 

and immediately called for an ambulance for further investigation and treatment. 
	 	 • �Remain calm and deal with any chaos quickly to avoid hazards. 
	 9.	Few basic safety rules for using electrical equipment at home and at workplace are as follows:
	 	 • �Electrical equipment used should be approved by a recognised organization. 
	 	 • �Make sure electrical equipment is properly connected, grounded and in good working 

order. 
	 	 • �Unqualified personnel should not interact with electrical machinery. Workers should be 

trained to handle electrical equipment safely. 
	 	 • �Damaged or hazardous electrical equipment should be immediately replaced. 
	 	 • �Physical barriers should always be used to protect employees from any electrical hazards. 

Cabinet doors on electrical panels should always be closed, and panels should not have 
holes where an employee could come into contact with exposed wires. 

	 10. �Peer to Peer Architecture is a network of computers where each node in a network is 
capable of being both clients and servers. Each node equally contributes to the processing 
requirements in a network, that’s why it is called Peer to Peer.

	 	   �In Client-Server Network, Clients and server are differentiated, Specific server and clients 
are present while in Peer-to-Peer Network, Clients and server are not differentiated.

C.
1.	 a.   Internet Service Provider provides accessibility to use Internet through its server. An ISP 

usually supplies the access rights with a username and password.
	 b. i. Wireless Access Point          ii. World Wide Web
	 c.	Two advantages of Networking are as follows:
	 	 • �Data Sharing: One of the most important benefits of networking is that it enables to share 

data among networked computers irrespective of locations.
	 	 • �Files Transfer: Users can send text files, spreadsheets, documents, presentations, audio files, 

video files, etc. to other users.
	 d.	�Blog refers to uploaded comments on www. It is a platform where writers or opinion makers 

share their views on any subject of their choice.
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		  Two Online Blogging websites are as follows:
		  www.WordPress.com 	 www.weebly.com 
2. 	 a.	Two options that Rahul can use to make payment of his bill on the online shopping website are:
	 	 • �Online banking
	 	 • �Cash on delivery
	 b.	Online shopping could be useful when:
	 	 • �A customer does not have sufficient time to visit stores 
	 	 • �A product or service that is not available in the local market is available online.
	 c.	Two popular e-commerce websites are Amazon and Flipkart.
	 d.	The full form of COD is Cash On Delivery.
3. 	 a.	�The purpose of blog is to create the content and post it for others to read or share, just like 

an online personal diary.
	 b.	Two websites that provide blog service are as follows:
	 	 • �www.WordPress.com 
	 	 • �www.medium.com
	 c.	The purpose of offline blog is to create blog posts without any connectivity to the Internet 

connection and publishes the blog whenever Internet connectivity is available.
	 d.	Two free offline blog editors are:
	 	 • �BlogDesk	 • �Qumana
4.	 a.	�Website:  A website is a collection of one or more web pages that displays information with 

the help of a web browser.
	 b.	Protocols: They are the set of rules or conventions to be followed while transferring data in 

a network.
5.	 Some rules or etiquettes to be followed while chatting on the Internet are as follows:
	 • �Introduce yourself before you begin with the conversation. If your chat name does not reflect 

your proper name, then begin by introducing your name. 
	 • �Ask the other person, if he is available and have time to chat. 
	 • �Keep your messages short and precise. It is a better way to communicate especially in a 

professional environment. 
	 • �Use proper punctuations to make it readable and understandable. 
6. 	 a.	�Phishing is one of the most common cyber-attacks that everyone should learn about in order 

to protect themselves. It is a fraudulent practice of sending emails to reputed companies or 
personnel in order to incite them to reveal their financial and personal information so that 
they can steal sensitive data like credit card or login information, or to install malware on the 
victim’s machine.
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	 	 Spoofing means faking someone’s identity. It is done by fake emails, text messages and 
websites created to look like they’re from authentic companies. They’re sent by criminals to 
steal personal and financial information from you.

	 b.	Three guidelines that we can follow to prevent cybercrime are as follows:
	 	 • �Make it a habit to keep changing passwords frequently with alphabets, digits and symbols. 

Never use the same passwords on several apps/websites. 
	 	 • �Firewalls can be added to strengthen your security system and to protect you from unwanted 

traffic.
	 	 • �Pay attention to the web camera LED indicators (they’re red on external devices and blue 

on laptops).
	 c.	Two rules that we can follow to keep our passwords strong are as follows:
	 	 • �Use a unique password for your important accounts whether email or online banking. Avoid 

using the same password for different accounts.
	 	 • �Your password should be at least 12-14 characters long.It should be a combination of 

lowercase and uppercase letters, numbers and symbols. A long password will offer more 
protection than a short password if it is properly constructed.

	 d.	We need a firewall for our computers because, it protects the system from unauthorised access 
and ensures that requests for transaction intrude to a system from authorised workstation 
only.

Previous Years' Questions

1.	 Internet service provider (ISP)
2. 	 Blog
	 Two examples of websites that help us to create such discussion style sites for free are 
	 • www.tumblr.com 
	 • www.blogger.com 
3.	 Two differences between LAN and WAN are as follows:

LAN WAN

LAN stands for Local Area Network. WAN stands for Wide Area Network.

LAN covers a small geographical area. WAN covers a large distance geographical area

4.	 c. 
5.	 Accessibility Options 
6.	 �Blog refers to uploaded comments on www. It is a platform where writers or opinion makers 

share their views on any subject of their choice. Two websites that offer free blog services are: 
www.WordPress.com and www.wix.com 
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7.	� Embedding an object makes it part of the document while linking an object does not include 
the object file into the document files. 

	 �Users trying to access the linked object must also have direct access to the separate file that 
forms that object. 

	� Linking means change in source file reflected in the target file but Embedding means change 
in source file does not reflect in the target file. 

	� Yes, embedding a document increases the size of the document. 
	� Some of the websites that have free clip arts are: 
	� www.openclipart.org 
	� www.pdclipart.org 
8. 	 •	 Cognitive impairments and learning disabilities, such as Dyslexia, Attention Deficit-

Hyperactivity Disorder (ADHD) or Autism. 
	 •	 Visual impairment such as low vision, complete or partial blindness and colour blindness. 
	 •	 Hearing impairment including deafness. 
9.	 •	 Peer-To-Peer (P2P) Architecture: Networks, in which all the computers are connected to each 

other under different topologies and where each workstation has an equal right to access 
data on a network, is said to be peer to peer network. 

	 •	 Client-Server Architecture: In many networks, data or information resources are mainly stored 
in a centralized computer of higher configuration. The computers which receive & share the 
information as and when required are terminals. Computers which store the data and provide 
resources are called servers and the terminals that avail the centralized resources are said to 
be clients. Such architecture of network is said as Client-Server. 

10.	 hearing 
11.	 Internet Service Provider 
12.	� Peer-To-Peer (P2P) Architecture: Networks, in which all the computers are connected to each 

other under different topologies and where each workstation has an equal right to access data 
on a network, is said to be peer to peer network.

13.	 �When data gets sent over the Internet, it is first broken up into smaller packets which are then 
translated into bits. The packets get routed to their destination by various networking devices 
such as routers and switches. When the packets arrive at their destination, the receiving device 
reassembles the packets in order to use or display. 

14.	 a. �Web server is the principal computer or server that links or stores contents of different 
websites. It provides data and information to computers on request via Internet. 

	      �In other words, it can be said that web server is a computer that stores data and runs software 
that are designed to send web pages in file format when requested by the web browsers. 
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	 b.	It is a type of connectivity that uses modem and the telephone lines to connect to the Internet. 
A modem must be connected to a telephone (not in use for voice calling). It is a commonly 
used connection for home PCs to connect to the Internet. 

	 c.	 �Wi-Fi (Wireless Fidelity) is a network of wireless connection. It is a mode of communication 
network that is established by radio frequency like that of Bluetooth, but it has more power, 
resulting into a stronger connection. Wi-Fi is sometimes called ‘Wireless Ethernet’. Wi-Fi 
connections are commonly established in electronic gadgets including video game console, 
home networks, PDAs, tablets, mobile phones, i-Pad, i-Pod, etc. A Wi-Fi enabled device such 
as a PC or PDA can connect to Internet within a range of (Wi-Fi) wireless network that is 
connected to the Internet. 

15.	 b. 
16. 	 a. 
17.	 Three features of Instant Messaging Service are as follows: 
	 •	 It provides private and secure online chat. 
	 •	 Text Messages can be sent to one or more person. 
	 •	 It provides audio and video calling and conferencing. 
18.	 a. Text Editor 
	 b. Web Browser
19.	 First Aid
20.	 Firewall
21.	 Four rules to manage strong passwords are as follows:
	 •	 �Use a unique password for your important accounts whether email or online banking. Avoid 

using the same password for different accounts.
	 •	 �Your password should be at least 12-14 characters long. It should be a combination of 

lowercase and uppercase letters, numbers and symbols. A long password will offer more 
protection than a short password if it is properly constructed.

	 •	 �Do not use personal information such as your name, age, date of birth, child’s name, pet’s 
name, or favorite color/song when constructing your password.

	 •	 �Avoid consecutive keyboard combinations (i.e. qwerty or asdfg).

LAB ACTIVITY

Do Yourself


